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1. Safety Issues

This manual contains notices which you should 
observe to ensure your own personal safety, as 
well as to protect the product and connected 
equipment. These notices are highlighted in the 
manual by a warning triangle and are marked as 
follows according to the level of danger:

The word “Warning” indicates that death, severe 
personal injury or substantial property damage 
can result if proper precautions are not taken.

The word “Caution” indicates that minor 
personal injury or property damage can result if 
proper precautions are not taken.

NOTE: The word “Note” draws your attention to 
particularly important information on the prod-
uct, handling the product or to a particular part 
of the documentation.

The symbol shown above is used whenever 
high voltage is present.
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1.1 Qualified Personnel

The VÅNTEC-1 may only be set up and oper-
ated in conjunction with this manual. Only per-
sonnel authorized by Bruker AXS are allowed to 
work on this equipment. All repairs, adjustments 
and alignments performed on any components 
of the VÅNTEC-1 must be carried out strictly in 
accordance with the established safety prac-
tices and standards of the country where the 
equipment is installed.

1.2 Correct Usage

This device and its components may only be 
used for the applications described in this man-
ual and only in connection with devices or com-
ponents from other manufacturers which have 
been approved or recommended by Bruker 
AXS.

This product can only function correctly and 
safely if it is transported, stored, set up and 
installed correctly and operated and maintained 
as recommended by Bruker AXS. Protection 
provided by this equipment may be impaired if it 
is used in a manner not specified by Bruker 
AXS.

1.3 X-ray Equipment

X-ray equipment produces potentially harmful 
radiation and can be dangerous to anyone in the 
immediate vicinity unless safety precautions are 
completely understood and implemented. All 
persons designated to operate or perform 
maintenance need to be fully trained on the 
nature of radiation, X-ray generating equipment 
and radiation safety. All users of the X-ray 
equipment are required to accurately monitor X-
ray exposure by proper use of X-ray dosimeters.

For safety issues related to the operation and 
maintenance of your particular X-ray generator, 
diffractometer and shield enclosure, please refer 
to the manufacturer operation manuals or your 
Radiation Protection Supervisor. The user is 
responsible for compliance with local safety reg-
ulations.

Voltage Danger—Before installing or 
servicing the detector, switch off the system to 
avoid high voltage.
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Inside the VÅNTEC-1, voltages up to 15 KV DC 
occur which are not accessible from the outside. 
High voltages exist inside the detector and in 
the cables with the label “HV” connecting the 
detecting unit and the control rack. After turning 
off the system, high voltages are still present. 
They discharge over time. Wait a few minutes 
before removing cables from the controller unit. 
If one of these high-voltage components is dam-
aged, switch off the system immediately and 
contact your local Bruker AXS Service Depart-
ment (in the U.S.A., 1-800-234-XRAY).

Sometimes complex D8 systems will be 
supplied by several power supply lines. The 
system and its components will be live until all 
power lines connected to the system are 
disconnected from the mains power supply.

The following warning symbols are displayed on 
the detector. Strictly obey all instructions and 
warning text printed on the labels attached to 
the various parts of the equipment.

Wait 60 seconds after turning off HV power 
before removing HV connectors!

X-ray window is Beryllium.

Any activity that scratches the window surface 
can generate airborne Beryllium dust which can 
cause lung disease if inhaled.

Beryllium metal in solid form, and as contained 
in this product, presents no special health risks.

For additional information, reference MSDS.

The rating plate is also displayed on the detec-
tor.

Model #: 672-___________
100-240 VAC
50/60 Hz, 120 W
Fuse Rating: F, 3.15 A, 250 V
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1.4 Hazardous Materials

The VÅNTEC-1 optic assemblies contain a 
beryllium window. Beryllium is potentially 
hazardous if ingested, inhaled or absorbed 
through the skin. Take care to avoid contact with 
the VÅNTEC-1 X-ray window. Never drill, grind 
or sand beryllium unless you are a qualified 
individual using appropriate respiratory 
equipment and dust containment and collection 
apparatus. Disposal of parts containing 
beryllium must comply with all applicable local 
and national regulations.

1.5 Proper Lifting 

Installation of the detector requires lifting of 
components that weigh up to 43 lbs (19.5 kg). 
Whenever possible, two or more people should 
lift objects together. Use proper lifting tech-
niques at all times. Use the following steps as 
an overview of proper lifting techniques.

1. Plan: practice the lift. While lifting, bend at 
the knees, keep your back straight, tighten 
your stomach and lift with your legs.

2. Position: keep your body close to the object 
you wish to lift—your stability increases the 
closer you are to the object. Keep your feet 
shoulder width apart.

3. Movement: avoid making awkward move-
ments while holding a heavy object. Get 
help if the object is too heavy or cumber-
some.
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2. Introduction

This manual covers installation and basic opera-
tion of the VÅNTEC-1 detector.

The VÅNTEC-1 detector features the fastest 
simultaneous recording of X-ray diffraction pat-
terns within a wide 2-theta angular range. When 
performing XRD experiments, the detector can 
be used either in fixed PSD mode (snapshot) or 
in locked coupled mode (similar to using a zero-
dimensional scintillation counter). For powder 
XRD, the VÅNTEC-1 offers a reduction of the 
overall measurement time up to a factor of 100 
in comparison to measurements executed with 
the commonly used zero-dimensional detector 
setup, providing a similar angular resolution. 
Furthermore, the fixed 2-theta mode allows 
measurement times down to 100 msec with 
about 12° 2-theta coverage for executing in-situ 
investigations like recording an “X-ray movie” of 
kinetic processes.

The active area of the detector is 50 mm by 16 
mm (along the scattering plane respectively per-
pendicular). The simultaneously-recorded angu-
lar range, as well as the achievable angular 
resolution, are influenced by the sample proper-
ties, the selected measurement circle diameter, 
the used slit openings and the applied X-ray 
wavelength. Generally, the para-focusing 
Bragg-Brentano geometry and a larger mea-
surement circle diameter result in a better angu-
lar resolution.

The VÅNTEC-1 detector is based on the pat-
ented MikrogapTM technology. It offers all the 
benefits common with gaseous detectors, such 
as high signal amplification resulting in high 
peak-to-background ratio, high sensitivity for a 
wide range of X-ray wavelengths, and a good 
energy resolution. The MikrogapTM technology 
allows operation at count rates much higher 
than those typically possible with gaseous 
detectors while maintaining all benefits. The 
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VÅNTEC-1 detector has energy resolution for all 
common characteristic X-ray emission lines 
from Cr through Mo; the default is Cu.

The factory settings are optimized for Cu-Kα. 
The electronic energy window allows the opera-
tor to set a discriminator window optimized for 
the X-ray wavelength used in the experiment, 
minimizing the background scattering or fluores-
cence impact on the recorded diffractogram.
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3. System Description

Figure 3.1 - VÅNTEC-1 detector

The VÅNTEC-1 consists of four parts that are 
installed in the D8 system: the detector, the 
detector controller, the fast diffraction controller 
(FDC) and the optics. This section also contains 
information on the counterbalance and both 
integrated and external FDCs, as these compo-
nents may vary depending on your configura-
tion.

The newest VÅNTEC-1 configuration has the 
FDC integrated into the detector controller hous-
ing. Only three parts need to be installed in the 
D8 system: the detector, the detector controller, 
and the optics.
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3.1 The Detector

The detector consists of a pressure vessel at 
3.04 bar (3040 hPa, 3 ATM) with a back cover 
(see Figure 3.1). The VÅNTEC-1 is a single 
photon counting detector which converts the X-
ray photons to electrical signals. The signals are 
amplified by three preamplifiers attached to the 
detector. The high-voltage filter and preamps 
are mounted into the back cover of the detector.

3.1.1 Detector Cables and Connectors

The back cover has six cable connectors:

• One connector for the preamplifiers’ low 
voltage power supply

• Two cables for the detector’s high-voltage 
supply

• Three signal outputs for the preamplifiers

Ten cables are delivered with the detector (see 
Table B.1 for part numbers):

• Ethernet crossover patch cable with RJ-45 
connectors

• Power cable

• Motor clock cable

• Serial cable

• Three 15 ft (5 m) preamp cables (Ch 1,     
Ch 2, Ch 5)

• Low-voltage (detector) cable

• Power cable

For configurations with an external FDC, an 
additional power cord, serial cable, and TDC to 
FDC data cable are included.

Table 3.1 summarizes the detector specifica-
tions.
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Detector Specifications

Suitable systems All D8 SUPER SPEED SOLUTIONS™ systems, all 
D8 systems, and the D4 ENDEAVOR

Active area 50 mm x 16 mm; 1,600 pixels (in the scattering plane 
x perpendicular)

Max 2-theta range simultaneously covered 12° at 435 mm measurement circle diameter, 11° at 
500 mm

Usable wavelength range From Cr-Kα up to Mo-Kα, factory-set default for
Cu-Kα

Gas fill 3.04 bar (3040 hPa, 3 ATM) non-polymerizing Xe-
CO2 gas, no external gas supply required

Radiation hardness > 1012 counts/mm2

Readout dead time None

Internal dead areas None

Maximum local count rate 400,000 cps

Energy resolution 10% with 55Fe radiation at 5.9 keV

Spatial resolution < 50 µm, > 1,600 individual readout channels

Window type Be

Voltage of power supply 100–240 V AC

Frequency of power supply  50/60 Hz

Power rating 120 W

Table 3.1 – Basic specifications of the VÅNTEC-1
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Detector overall dimensions and weight 3.5 in H x 3.1 in W x 7.5 in D, 4.4 lbs (90 mm H x 
80 mm W x 190 mm D, 2 kg)

Controller chassis unit 5.25 in H x 19 in W x 16 in D, 35 lbs (133 mm H x 483 
mm W x 406 mm D, 15.9 kg)

External FDC unit (if present) 3.5 in H x 19 in W x 16.25 in D, 10 lbs (90 mm H x 
480 mm W x 410 mm D, 4.5 kg)

Length of cables between the detector and 
the controller chassis unit

16.4 ft (5 m)

Disconnect device IEC 320 connector/plug on power supply cord

Software DIFFRACplus Measurement package version 2.4 or 
higher

Included in delivery VÅNTEC-1 detector; front-end read-out and supply 
electronics; mounting and optics assembly, including 
Kβ-filter, 2.5° Soller slit and primary beam stop

Detector Specifications

Table 3.1 – Basic specifications of the VÅNTEC-1
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3.1.2 Environmental Ratings

Table 3.2 shows the range of environmental 
conditions for which the equipment is designed.

Table 3.2 – Environmental ratings of the detector

3.2 The Detector Controller

The detector controller currently has the FDC 
integrated within the detector controller. Previ-
ous configurations have an external FDC unit. 
Both configurations are discussed in this man-
ual.

3.2.1 Identifying Integrated and External 
FDC configurations

Older detector controllers contain the electronic 
circuit boards for signal processing, the detector 
(high-voltage) power supply, a power supply for 
the detector preamplifiers, the Constant Fraction 
Discriminator (CFD) boards, the Time to Digital 
Converter (TDC) boards, and all electronic 
assemblies. All of these units are placed within 
the same 19" housing as shown in Figure 3.4.

In these older configurations, the FDC is an 
external unit.

Newer detector controllers have FDC controller 
integrated within the detector controller chassis.

Ambient temperature 41–104°F (5–40°C)

Operating temperature 57–93°F (14–34°C)

Maximum temperature 
gradient

+ 0.9°F (+ 0.5°C) per hour

Relative humidity Max 80%, non-condensing, 
for temperatures up to 
88°F (31°C) decreasing 
linearly to 50% at 104°F 
(40°C)

Location of use Indoor

Altitude Up to 1.2 miles (2000 m)

Mains supply voltage 
fluctuations

Up to +10% of the nominal 
voltage

Overvoltage category IEC 664 II

CE certification See Appendix D

Pollution degree 2
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To determine which type of detector controller 
you have, simply examine the rear panel of the 
detector controller.

External FDC: The uppermost slot on the right-
hand side of the detector controller’s rear panel 
contains both a DB9 male connector and a 
DB25 male connector (Figure 3.2).

Figure 3.2 - External FDC identification

Integrated FDC: The uppermost slot on the 
right-hand side of the detector controller’s rear 
panel contains only a DB9 male connector. The 
DB25 male connector is missing (Figure 3.3).

Figure 3.3 - Integrated FDC identification
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Figure 3.4 - Block diagram of the detector controller
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Figure 3.5 - Detector controller (outside, front)

Illuminated high voltage 
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Figure 3.6 - Detector controller (outside, back)

Grid HV

Power receptacle
Low voltage 
connector

Ch 1

Ch 5

Data I/O
COMM 2

COMM 1

LAN

Anode HV

Ch 2

CFD Out

Motor clock

External 
FDC data



System Description VÅNTEC-1 Detector User Manual

3 - 10 M88-E01072

3.3 The External Fast Diffraction 
Controller (FDC)

The FDC is a microprocessor unit for control 
and data readout of the VÅNTEC-1 detector. It 
is wired to the computer’s diffractometer control 
data connection chain.

Features:

• LCD display (132 x 39 mm)

• Two serial interfaces

• Integrated multi-channel analyzer

• 19" unit

• Online display of the measured 2-theta dia-
gram on the LCD display

NOTE: FDCs for the D5000 and D500 may 
need to have minor hardware modifications. 
Contact Bruker Service—have the serial num-
ber of the FDC available.

r

Figure 3.7 - FDC

back

front
Power switch Contrast control
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The front display of the FDC will graphically 
show a selected subset of the measuring 
channels and three values.

Figure 3.8 - FDC display for fast diffraction (locked-coupled) mode

 Y-scale in counts
 2-theta value in degrees

 Accumulated counting time in seconds

XXXX
XXXX

XXXX
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3.4 Detector Optics

The optic of the detector consists of six compo-
nents: detector window slits, Debye slits 
(optional), Kβ filter, anti-scatter slits, Soller slits 
(default 2.5°, 4.0° optional) and window opening 
scales.

The Kβ filter and Debye slits have notches 
which fix the slit in position when properly 
inserted. The anti-scatter slit assembly length 
used depends on the measuring circle, one for 
435 mm and one for 500 mm (see Figure 3.9).

Figure 3.9 - Anti-scatter slit assembly options
(short and long)

Short anti-
scatter slit 
assembly

Long anti-
scatter slit 
assembly

Detector 
optic

Anti-scatter 
slit screws
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The optic of the detector consists of six compo-
nents (see Appendix B for part numbers):

1. Detector window slits

2. Debye slits (optional)

3. Kβ filter

4. Anti-scatter slits (near sample window slits)

5. Soller slits

6. Window opening scales

Figure 3.10 - Detector optic

Figure 3.11 - Close-up view of slits/filter
2

5

3

4

1

6

kβ filter

Debye slits

Soller slit

notch

pin
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3.4.1 Beam Stop

The beam stop blocks any X-rays from striking 
the face of the detector at low incident angles. 
The beam stop has three directions of move-
ment.

1. Selects an adapter for the beam height 
(default height is 150 mm).

2. Adjusts beam stop for 401, 435 and 
500 mm circles.

3. Adjusts beam stop up and down (height).

4. Adjusts beam stop tilt.

Figure 3.12 - Beam stop

1. Adapter plate

4. Tilt 
adjustment

3. Height
adjustment

2. Beam stop adjustment 
(behind adapter plate)
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3.4.2 Air Scatter Screen

The purpose of the air scatter screen is to 
reduce primary air scatter which influences the 
background of the diffraction pattern, usually at 
lower angles. The air scatter screen can be 
attached to the primary optics. The air scatter 
screen will mount to either the motorized or 
fixed primary optics or to the Göbel mirrors.

Figure 3.13 - Air scatter screen

 Top

 Bottom
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3.4.3 Radial Soller Slit

The purpose of the radial Soller slit is to reduce 
both primary and secondary air scatter which 
influences the background of the diffraction pat-
tern. The peak intensity phases, with small sam-
ple amounts, are determined more easily and 
can be detected earlier. The radial Soller slit is 
needed for the linear detector VÅNTEC-1, 
Göbel mirrors (Parallel beam geometry) or pri-
mary focusing monochromators in transmission 
mode. The final settings have to be tested with 
an intensity standard like NIST SRM1976 
Corundum plate or NIST SRM640c Silicon pow-
der filled in capillaries.

NOTE: The radial Soller slit cannot be used with 
Bragg-Brentano focusing geometry due to differ-
ence in the beam path. When using Göbel mir-
rors or primary monochromators, no Kβ filter is 
needed. Fixed mode measurements will also fail 
because only the center of the detector will 
show useful signals.

The radial Soller slit has two degrees of freedom 
(DOFs). Position the DOFs using dovetails and 
fine adjustment screws (see Figure 3.14). The 
first DOF is the translation movement along the 
tangent of the measuring circle (tangent axis) 
and the second is the radial movement along 
the radius (radial axis).

Figure 3.14 - Radial Soller slit

Tangent 
alignment

Radial 
alignment
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Figure 3.15 - Transmission ray tracing

2θ

Tangent Axis
Radial Axis
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3.5 Counterbalance

The counterbalance is located on the back of 
the goniometer. Figure 3.16 shows an example 
of a counterbalance on a θ/θ goniometer. The 
addition of a counterbalance provides smooth 
and flawless movement of the goniometer. The 
position of the counterbalance is based on the 
weight of the detector and optics, the measuring 
circle diameter, and the height of the sample 
stage. In order to ensure proper weight distribu-
tion, please use the tables below to select the 
correct position of the counterbalance for the 
detector system. Table 3.3 refers to the posi-
tions shown in Figure 3.17.

Figure 3.16 - Counterbalance on the goniometer
Stage Height (mm) 150         214          258

Circle Diameter (mm) 435 500 600

Handle -4 -1 1

Weight B B B

Table 3.3 – Position of the handle and weight for the 
counterbalance
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Figure 3.17 - Counterbalance positions
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4. Hardware Installation for the D8 
ADVANCE

This section describes hardware installation for 
a D8 ADVANCE.

4.1 Servicing Precautions

When the equipment is connected to the mains 
supply, some terminals, components, and 
multiple power supply lines may be live. It is not 
sufficient to just press the D8 enclosure’s Power 
OFF button (O) or the on/off power switch on the 
VÅNTEC-1 controller. The mains supplied to the 
system must be switched off externally.

Components attached to the goniometer will 
move during operation. Use proper lifting 
methods for the detector controller and the 
detector components.
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4.2 Shipping and Unpacking

1. Check for external shipping damage to the 
packages.

2. Open the boxes containing the detector and 
its components.

3. Check for any damage to the components.

4. Inventory all items for completeness.

5. Save the packaging when practical for 
return shipping.

4.3 Baseline Data

Before making any installation or calibrations to 
the diffractometer, run and save a standard 
Bragg-Brentano scintillation scan using the set-
tings in Table 7.1 or Table 7.2. The data file will 
be the baseline for comparison of the data col-
lected using the VÅNTEC-1 controller. The 
baseline data should be collected with a stan-
dard reference material (SRM) like the NIST 
1976 corundum plate (see the Instrument Verifi-
cation Booklet M88-Zxx041 for additional sys-
tem parameters).
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4.4 Hardware Installation (for detec-
tor controllers with an external 
FDC)

The following sections discuss the integration of 
the detector in D4 and D8 systems in response 
to developments in the area of integrating the 
FDC with the second-generation D8 axis 
indexer board (AIB2G).

Beginning March 2005, the D8 FOCUS, D8 
ADVANCE and D8 DISCOVER systems will be 
equipped with the AIB2G (C79298-A3220-B231 
and C79298-A3220-B232).

• See Section 4.4.1 for detector controllers 
with external FDC (see Section 3.2.1 for 
identification).

• See Section 4.5 for detector controllers with 
internal FDC (see Section 3.2.1 for identifi-
cation).

• See Section 4.6 for detector installation with 
A1B2G index board (D8 controllers installed 
after March 2005).

Use the following tools for this procedure:

• Torx screwdriver

• Allen screwdriver

Additional rails and hardware must be mounted 
to accommodate the VÅNTEC-1 controller and 
FDC in the D8. The location of the FDC and 
PSD controllers is critical for proper operation. 
There must be sufficient airflow around the con-
trollers to prevent the electronics from overheat-
ing. Do not place the VÅNTEC-1 controller in 
close proximity to the generator. This may 
induce electronic noise in the detector electron-
ics.

Use care when moving the detector head to 
avoid mechanical shock to the assembly.

See Table A.3 in Appendix A for the configura-
tion scheme.
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4.4.1 Mount the Rails

1. Additional rails (part number C79298-
A3242-C115), item C in Figure 4.1, must be 
added to accommodate the FDC controller.

2. Relocate the existing rails, A in Figure 4.1, 
for adequate airflow.

3. Mount the rails so there is a minimum space 
of 1" between the detector and FDC control-
lers.

4. Mounting the rails requires removing the 
front and rear columns of the system. 
Remove the screws located at position B in 
Figure 4.1 to detach the columns.

Figure 4.1 - Column and rail locations
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4.4.2 Install the Controllers

Location of the FDC and PSD controllers is criti-
cal for proper operation. Whenever possible, 
place the VÅNTEC-1 controller above the D8 
controller electronics (see Figure 4.2 for proper 

location in the D8). Allow at least 1" of open 
area around the top, bottom, and back of the 
units for adequate airflow. Remove the D8 front 
and side access panels and blank panels for the 
installation of the controllers.

Figure 4.2 - Location of FDC and PSD controller within the 
D8 ADVANCE
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4.4.3 Connect the Cable Wiring

See Figure 3.6 and Figure 4.3 for the connec-
tion of the wiring. Guide the (3) preamp, and (2) 
high voltage and low voltage wires through the 
safety labyrinth at the back of the D8 enclosure. 
Make sure that no cables will be pinched when 
closing the back cover. Use a serial cable ini-
tially to configure the VÅNTEC-1 controller for 
the final network connection.

Connect the following cables:

1. Connect the FDC controller, detector con-
troller, control PC and D8 system like the 
configuration shown in Figure 4.3.

1.1 Take the serial cables that are normally 
connected to the PC and connect them 
to COM 1/COM 2 of the VÅNTEC-1 
controller, respectively.

1.2 Disconnect the COM 1 cable on top of 
the D8 controller and connect it to the 
additional cable that is connected to 
SCOM 1 of the FDC controller.

1.3 Connect the cable coming from 
SCOM 2 of the FDC controller to 
COM 1 on top of the D8 controller.

All connectors have a positive lock to ensure 
proper connection.

2. Connect the BNC type connector from CH 1 
of the VÅNTEC-1 controller to the CH 1 con-
nector on the detector head.

3. Connect the BNC type connector from CH 2 
of the VÅNTEC-1 controller to the CH 2 con-
nector on the detector head.

4. Connect the BNC type connector from CH 5 
of the VÅNTEC-1 controller to the CH 5 con-
nector on the detector head.

5. Connect the low voltage of the VÅNTEC-1 
controller to the low voltage connector on 
the detector head.

NOTE: Use caution with the connectors and 
cables for the high voltage.

The connectors are made of a Teflon material, 
which can be damaged if not properly installed.

6. Connect the high voltage grid of the detec-
tor head to the high voltage grid connector 
on the VÅNTEC-1 controller.

7. Connect the high voltage anode of the 
detector head to the high voltage anode 
connector on the VÅNTEC-1 controller.

NOTE: The HV connector has to be properly 
aligned. This should be done at the factory.

8. Attach the grounding strap to the ground 
plate on the left-side panel.
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Figure 4.3 is a system block diagram that illus-
trates the major detector system components 
and the cabling for communication.

Figure 4.3 - Configuration setup
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4.4.4 Connect the Power Supply

Check that the detector controller power cord is 
connected to X601 on the left side of the D8 
enclosure. The FDC controller must also be 
connected to the mains power.

Servicing Precautions—When the equipment is 
connected to the mains supply, some terminals 
of the mains distribution unit may be live. 
Therefore, it is absolutely necessary to switch 
off the external mains supply before opening the 
housings. It is not sufficient to just press the on/
off power switch on the VÅNTEC-1 controller. 
The mains supply must be switched off 
externally on the customer’s side (wall socket or 
external switch).

4.5 Hardware Installation (for detec-
tor controllers with an inte-
grated FDC)

4.5.1 Mount the Rails.

1. Relocate the existing rails, A in Figure 4.4, 
for adequate airflow.

2. Mounting the rails requires removing the 
front and rear columns of the system. 
Remove the screws located at position B in 
Figure 4.4 to detach the columns.

Figure 4.4 - Column and rail locations
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4.5.2 Connections and Cable Wiring

The latest version of the VÅNTEC-1 runs with 
an integrated FDC located inside the detector 
controller. Cabling (see Figure 4.6) differs in 2 
ways compared with Figure 4.3:

1. The serial cables, used for measuring and 
service, are connected directly between the 
COM ports of the detector controller and the 
D8 Electronics Rack. COM1 is for Measur-
ing, COM2 is for Service.

2. The motor clock cable (A17-D42) must be 
connected between the 9-pin STEP/DIR 
port on the rear of the detector controller 
(see Figure 4.5) and either: 

• For D8 systems, the X5 9-pin port on the 
B104 2-axis indexer board, or

• For D4 systems, the socket on the bracket 
of the B105 4-axis indexer board.

Important: When replacing the clock signal 
cable for an external FDC, there is an additional 
adapter with two 9-pin plugs labeled either:     
“T-T” for D8 Theta-Theta goniometer, or          
“T-2T” for D4 or D8 Theta-2Theta goniometer 
(A17-D43). 

After connecting the cables, switch on the 
detector controller and D8/D4 system.

 

Figure 4.5 - Back panel of the VÅNTEC-1 detector 
controller. The circle shows the connection 
STEP/DIR for the motor clock signal.

STEP/DIR
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Figure 4.6 - Wiring of VÅNTEC-1 detector controller with 
integrated FDC
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4.6 Install the Network Card

1. Prepare your computer and work area.

2. Turn off the power and unplug your com-
puter.

2.1 Do not attempt to open the computer 
case while it is on.

2.2 Do not work on components inside of 
the computer while it is on.

Risk of electric shock. Do not attempt the 
installation with power applied to the computer.

3. Open the computer case. Computer cases 
are held together in different ways—consult 
your computer’s manufacturer for details.

Removal of retaining screws may be 
required.

Some models have plastic snaps at the cor-
ners or edges of the case. Release the 
cover with a squeeze or pull.

4. Select an open expansion slot on the com-
puter’s system board.

4.1 Remove the cover plate (i.e., blank 
plate covering the opening). In most 
cases, the cover plate is held in place 
with a screw.

4.2 The network card must fit into an appro-
priate and available expansion slot.

5. Insert and secure the card.

5.1 The card should fit fully and squarely 
into the slot. The card may need to be 
rocked gently in order to get it to seat.

5.2 Secure the card to the computer case 
with a screw.

5.3 Check to make sure you have not dislo-
cated other wiring or components.
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Take care not to damage components of the 
card or touch the connector edge. The network 
card and its components contain 
electrostatically sensitive devices. Before 
touching the network card, the servicing people 
should discharge themselves by touching an 
earthed, grounded object.

Figure 4.7 - Insert the network card

6. Replace the case. Secure any screws.

7. Turn on your computer and allow it to boot-
up normally.

8. To complete the installation, go to Section 
6.

4.7 Installation of the detector con-
troller using second-generation 
indexer boards (AIB2G)

The cabling and configuration of a VÅNTEC-1 
running with the second generation of Axis 
Indexer Boards (AIB2G) is different than that 
mentioned in Section 4.4.3. This section 
describes cabling and configuration of a VÅN-
TEC-1 with AIB2G.

4.7.1 Requirements

• 2 Axes Indexer Boards C79298-A3220-
B231 for D8 systems

• 4 Axes Indexer Boards C79298-A3220-
B232 for D4 and D8 systems

• DIFFRACplus Measuring Package Release 
2.4.1

• D8 Controller Firmware 3.0

• D4 Controller Firmware 2.0
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4.7.2 Connection and Cable Wiring

The cabling differs in one way compared to that 
in Figure 4.6:

1. The motor clock cable (A17-D42) has to be 
connected between the 9-pin socket STEP/
DIR of the Detector Controller or external 
FDC and either:

• For D8 systems, the X5 9-pin socket on the 
B231 2-axis indexer board, or

• For D4 systems, the socket on the bracket 
(X11) of the B232 4-axis indexer board.

 

NOTE: The clock signal cable can be one of two 
cables, one straight and one Y-shaped. If you 
are running the system with the AIB2G, NEVER 
use the Y-shaped adapter cable (A17-D43) in 
any case!

After connecting the cables, switch on the 
detector controller and D8/D4 system.

     

Figure 4.8 - Clock signal cable (A17-D42)

Figure 4.9 - Y-shaped adapter cable (A17-D43).          
NOTE: Use only for first-generation indexer 
boards (AIB) B104/B105.
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4.7.3 Hardware Installation

Configure the VÅNTEC-1 detector as shown in 
Figure 4.6. Connect the AIB2G to the system. 

NOTE: Power down the complete D8 system 
before changing circuit boards on the D8 
Controller Rack. Changing boards in the D8 
Controller Rack without powering down the 
system can damage both the boards and the 
Controller Rack.

NOTE: Never mix old and new Axis Indexer 
Boards! The boards may be rendered 
inoperable as a result.

When using the B104 or B105 Axis Indexer 
Boards, connect the motor clock cable and 
indexer cables as described in Section 4.5.2.

When using the 2-axis version of the AIB2G 
(B231), the motor clock cable must be attached 
to X5.

When using the 4-axis version of the AIB2G 
(B232), the motor clock cable must be attached  
to X11. The connection X11 is located on the 
bracket of the board (see Figure 4.10).

Figure 4.10 - Top view of the 4-axis AIB2G (B232). The X11 
socket is used for the Motor Clock Signal.

X11

front
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For a D8 system, connect the motor and 
encoder cables as shown in Table 4.1:

Table 4.1 – Motor and encoder cable connection for a D8 
system

Switch on the D8/D4 system.

Source (Theta-Theta / Theta-2Theta) Cable Connection on B231

Th-Tube / 2Theta Encoder 2 X4

Th-Detector / Theta Encoder 1 X3

Th-Tube / 2Theta Driver 2 X2

Th-Detector / Theta Driver 1 X1
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4.7.4 Software Configuration

1. Open the Configuration software from within 
the DIFFRACplus folder.

2. Under Motorized Drives, select B231/232 
from the “AIB Type” drop-down menu (Fig-
ure 4.11). This is standard for Theta-Theta 
or Theta-2Theta configurations.

Figure 4.11 - Motorized Drives section

4.7.5 Automated installation for AIB2G

For systems without 21 CFR Part 11 software, 
the system can be set to configure itself auto-
matically with regard to the source for the Clock 
Signal.

1. Open the Configuration software and select 
the Våntec-1 Setup window (Figure 4.12).

2. Check the Automatic Drive Configuration 
for Drive/Detector Synchronisation 
(B231/232 only) checkbox.

Figure 4.12 - Activation of the Automatic Drive Configuration

After the next download, the source of the Clock 
Signal is set automatically for Theta-Theta or 
Theta-2Theta configurations. 

If automatic installation was successful, you can 
skip the following steps regarding manual instal-
lation.
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4.7.6 Manual Installation for Theta-Theta 
Configuration

The following sections will show settings for dif-
ferent goniometer configurations. In 21 CFR 
Part 11 situations, manual setup is mandatory. 
Otherwise, the use of automated installation for 
the Clock Signal is recommended (see Section 
4.7.5).

1. Make sure that the Automatic Drive Config-
uration is disabled by unchecking the check-
box in Figure 4.12.

2. Select Advanced Board Setup > Two Axis 
Indexer Boards. Ensure that physical drive 
1 is connected to logical axis TH-Detector, 
and physical drive 2 is connected to logical 
axis TH-Tube (see Figure 4.13). 

Figure 4.13 - Manual settings for TH-TH

3. Select Motorized Drives > TH-Detector. 
Click Change Values.

Figure 4.14 - TH-Detector - change values
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4. Answer Yes to the confirmation message 
and click Additional Settings. The follow-
ing box appears (Figure 4.15). Select the 
axis that should deliver the Clock signal. 
Because the logical axis TH-Detector is 
sending the clock signals, this motor axis 
has to be chosen. From Figure 4.13, the 
“Axis” must be Driver 1. Set “Register” to 
Signal Status Register and “Bit” to (bit 11) 
Motor Clock - Bit 3.

Figure 4.15 - Motorized Drives section – TH-Detector – 
Advanced Configuration

5. Also check the settings of the logical axis 
TH-Tube in the same way. The parameters 
for “Sources for AxisOUT” must look like 
Figure 4.16.

Figure 4.16 - Motorized Drives section – TH-Tube – 
Advanced Configuration

6. Save and download the configuration.
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4.7.7 Manual Installation for Theta-2Theta 
Configuration

In 21 CFR Part 11 situations, manual setup is 
mandatory. Otherwise, the use of automated 
installation for the Clock Signal is recommended 
(see Section 4.7.5).

1. Make sure that the Automatic Drive Config-
uration is disabled by unchecking the check-
box in Figure 4.12.

2. Select Advanced Board Setup > Two Axis 
Indexer Boards. Ensure that physical drive 
1 is connected to logical axis THETA, and  
physical drive 2 is connected to logical axis 
2THETA (see Figure 4.17).

Figure 4.17 - Advanced Board Settings – Two Axis Indexer 
Board. Settings for Theta-2Theta.

3. Select Motorized Drives > Theta. Click 
Change Values.

4. Answer Yes to the confirmation message 
and click Additional Settings. The follow-
ing box appears (see Figure 4.18). The 
“Axis” must be set to Driver 2. Set “Regis-
ter” to Signal Status Register and “Bit” to 
(bit 11) Motor Clock - Bit 3.

Figure 4.18 - Motorized Drives section – Theta – Advanced 
Configuration
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5. Check the settings for “2Theta”. The param-
eters for “Sources for AxisOUT” have to 
look like Figure 4.19. 

NOTE: Do not worry about the fact that the set-
tings for “2Theta” show no settings for “Register” 
and “Bit”.

Figure 4.19 - Motorized Drives section – 2Theta – Advanced 
Configuration

6. Save and download the configuration.
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4.8 Optic Components

4.8.1 Mount the Detector Head to the 
2-Theta Axis

Mount the detector head in place of the scintilla-
tion detector or the previously installed detector. 
The detector will be shipped mounted and pre-
aligned to the two degrees of freedom (2 DOF). 
If this is not the case, follow the steps indicated 
below. Move the detector to different measuring 
circles to suit the installation.

1. Move the 2-theta drive to a position where 
the detector can be placed on the track 
(approximately 35° 2-theta).

2. Check that the setscrew is in the location 
shown in Figure 4.21. This ensures that the 
detector is at the proper measuring circle.

Figure 4.20 - New detector mount

Figure 4.21 - Detector mounting plate

 setscrew

back of detector

 front of detector

 Detector
 mounting
 screws
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3. Use Figure 4.22 to set the predefined mea-
suring circle on the theta and 2-theta tracks.

Figure 4.22 - Predefined measuring circle diameter pin 
locations
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4. To confirm the proper measuring circle 
radius, measure from a point at the center of 
the sample stage (goniometer center) to a 
point approximately 17 mm behind the 
detector faceplate. This spot should be 
marked on the detector head (see Figure 
4.23). Use this as a reference when placing 
the detector on the track.

Figure 4.23 - Connect and mount the detector

4.1 If not already attached, attach the 
detector to the 2 DOF mount with the 
detector mounting screws shown in Fig-
ure 4.21 and Figure 4.24.

4.2 Place the detector on the track. Slide it 
down to the pinned position and tighten 
the track mounting screws shown in 
Figure 4.24.

5. Connect the preamplifier, HV and low volt-
age cables to the detector.

6. Adjust the cable strain relief on the detector 
mount (see Figure 4.24).

Figure 4.24 - Strain relief

7. Move the 2-theta drive through the complete 
range to make sure the detector moves 
freely and is not restricted by the cables.

17 mm from edge of 
faceplate to line

Track 
mounting 
screws

Detector mounting 
screws
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4.8.2 Mount and Align the Beam Stop

The beam stop is mounted to restrict the main 
beam’s path (divergence).

An un-attenuated beam path may saturate the 
detector and prolonged exposure to main beam 
intensities may damage the detector.

To Mount the beam stop:

1. Move the 2-theta drive to 60°.

2. Insert the locking T-nut into the goniometer 
track (see Figure 4.25).

Figure 4.25 - Locking T-nut

3. Fasten the beam stop assembly to the goni-
ometer (see Figure 4.26).

3.1 Use the mounting pin to position the 
beam stop assembly.

3.2 Insert and tighten the mounting screw.

4. Mount the beam stop in one of the following 
positions using the “D” screws in Figure 
4.26.

A = 435 mm diameter measuring circle

B = 500 mm diameter measuring circle

C = 600 mm diameter measuring circle

Figure 4.26 - Beam stop (front view)

5. Slowly move 2-theta to 0°, checking that the 
beam stop does not collide with the anti-
scatter optics of the detector.

6. Adjust the beam stop as necessary to avoid 
a collision with the detector optics.

7. Raise 2-theta back to 60°.

8. Check that collision limits are set in the soft-
ware.

Mounting Pin
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To align the beam stop:

1. Attach fluorescent paper to the upper edge 
of the beam stop knife edge (item C in Fig-
ure 4.27).

2. Raise the beam stop using the thumb wheel 
(item A in Figure 4.27) until the edge is 
above 0° 2-theta.

Figure 4.27 - Beam stop (side view)

3. Open the shutter.

4. Observe the flux on the fluorescent paper.

4.1 Lower the room lights or cabinet lamps 
to make the beam visible.

4.2 If necessary, raise the kV/mA to make 
the beam clearer.

5. Lower the knife edge until the flux is clearly 
distinguished on the fluorescent screen.

6. Adjust the tilt, item B in Figure 4.27, of the 
knife edge until the beam appears homoge-
neous and has uniform intensity. The tilt 
adjustment is comprised of opposing set-
screws. When making an adjustment, also 
loosen the opposing screw.

7. Lower θ or the tube to 0°.

8. Raise the beam stop using the thumb wheel 
to cut off the beam.

9. Remove the fluorescent paper from the 
beam stop.

C
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4.8.3  Mount and Align the Air Scatter 
Screen

The air scatter screen will provide a greater 
noise-to-signal ratio, enabling better phase iden-
tification with smaller sample amounts. The air 
scatter screen is beneficial with linear detectors 
like the MBraun PSD or VÅNTEC-1. Do not 
move θ or the tube lower than 0° with the air 
scatter screen attached in order to avoid colli-
sion with the stage. The air scatter screen 
should be retracted during system alignment 
and when the scan range for theta is less than 
0°.

Complete the following steps for proper installa-
tion, alignment and use of the air scatter screen. 
Test the final settings with an intensity standard 
like the NIST SRM1976 Corundum plate. Use a 
procedure similar to that in the Instrument Verifi-
cation Booklet M88-Zxx041 for final documenta-
tion of the instrument results.

To mount the air scatter screen:

1. Attach the air scatter screen to the primary 
divergence slit devices.

2. Remove the flange plate by removing the 
two screws labeled “3” in Figure 4.28.

3. Mount the air scatter screen to the diver-
gence assembly by aligning the two holes to 
the matching alignment pin (item 4 in Figure 
4.28) located on the plates of the primary 
optics. See Figure 4.28 as an example of 
mounting for a variable divergence slit 
assembly.

4. The plates of the primary optics have two 
screw holes (item 3 in Figure 4.28) used for 
securing the air scatter screen to the diver-
gence assembly. Secure the air scatter 
screen using two Torx M3x10mm screws 
(item 2 in Figure 4.28).
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Figure 4.28 - Air scatter screen, exploded view
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2

3

4
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1

Translation
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Align the air scatter screen:

The alignment of the air scatter screen is depen-
dant upon the beam path of the system and the 
type of optics used. The alignment consists of 
two parts: the height of the paddle above the 
sample surface and centering the paddle to the 
center of the measuring circle. Because the 
sample holder is mounted onto the stage in the 
center of the goniometer, a fluorescent screen is 
used as a reference to the center line. The 
beam path of a Bragg-Brentano, para-focusing 
or parallel beam (Göbel mirror) condition will 
influence the gap between the paddle and the 
sample surface.

1. Before any alignment is made to the air 
scatter screen, run a measurement scan 
using the settings in Table 7.1 or Table 7.2. 
This data file will be the baseline for com-
parison to the data collected using the air 
scatter screen. The baseline data should be 
collected with a standard reference material 
(SRM) like the NIST 1976 corundum plate. 
See the Instrument Verification Booklet 
M88-Zxx041 for additional system parame-
ters.

2. For the tilt and translation adjustments, use 
a 2 mm Allen tool.

Perform manual alignment:

1. Run a measurement with predefined optical 
settings with SRM1976 or another similar 
reference material to define the intensity 
distribution (see M88-Zxx041).

2. Move the primary (theta or tube) drive to 0° 
theta.

3. Mount the fluorescent screen (P/N A13-
B71) onto the sample stage.

3.1 Set tilt to a reasonable value (see item 
5 in Figure 4.28).

3.2 Align the height of the gap between the 
paddle and the sample surface using 
tilt.

3.3 For a 0.6 mm (0.3°) divergence slit, use 
a gap of 2 mm as a starting point.

4. Align the translation of the screen so the 
paddle will be exactly centered to the sam-
ple (see Figure 4.29).

5. Repeat the measurement in step 1 and 
check the intensity distribution.

6. Close the height of the gap and realign the 
translation to keep the paddle centered.

6.1 Repeat steps 5 and 6 until the desired 
intensity distribution is met. Do not for-
get to compensate the translation 
movement of the air scatter screen.
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Figure 4.29 - Alignment of the paddle using the
fluorescent screen

Tilt
adjustment

Paddle  2 mm gap
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Figure 4.30 - Translation adjustment

Do not use smaller primary angles (tube angle 
or sample) than 0° theta in order to avoid a 
collision between the air scatter screen and 
sample holder.

Translation 
screw

Translation 
adjustment 
(behind 
plate)
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4.8.4 Mount and Align the Radial Soller Slit

Use the following tools for this procedure:

• NIST SRM 1976 Corundum plate (for reflec-
tion) or NIST SRM 640c Silicon powder (for 
transmission)

• Torx key set

• Allen key set

Mount the radial Soller slit:

1. Take off the kβ filter.

2. Attach the radial Soller slit onto the VÅN-
TEC-1 optics block using the two anti-scat-
ter slit screw holes shown in Figure 3.9.

3. Remove the anti-scatter slit assembly of the 
detector optics and mount the radial Soller 
slits with the two M3 screws. The alignment 
pin of the detector optics block has to be 
visible.

Figure 4.31 - Installation of the radial Soller slit

Fixing 
screws

Alignment pin

Clamping 
screws
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Align the radial Soller slit:

The radial Soller slit can not be used with Bragg-
Brentano geometry. The beam path of a primary 
focusing monochromator or parallel beam con-
dition (Göbel mirror) will influence two DOFs: 
tangent and radial axis. Perform the manual 
alignment as follows:

1. Run a baseline scan using the scan param-
eters listed in Table 8.1 with SRM1976 or 
powder in capillaries to define the intensity 
distribution (also see the Instrument Verifi-
cation Booklet M88-Zxx041).

2. Install the radial Soller slit (see Figure 4.31).

3. Run a lock coupled scan on the main peak 
and record the intensity.

4. Align the tangent axis and then the radial 
axis to maximize intensity. Make sure that 
the movements along the axis are smooth. 
Loosen the clamping screws as needed. 
The peak positions should not vary.

5. Repeat the measurement like in step 1 and 
compare the intensity distribution. There 
should be no intensity loss.

6. Tighten the clamping screws on both dove-
tails.
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5. Hardware Installation for the D4 
ENDEAVOR

This section describes hardware installation for 
a D4 ENDEAVOR. The installation of the VÅN-
TEC-1 detector in the D4 ENDEAVOR is differ-
ent from installation in the D8 ADVANCE in 
several ways. The main difference is related to 
the primary beam stop, which has to slide away 
in case of high-angle measurements. The 
detector mount and the cabling through the 
enclosure are also different.

5.1 Servicing Precautions

When the equipment is connected to the mains 
supply, some terminals, components, and 
multiple power supply lines may be live. It is not 
sufficient to press the D4 enclosure’s Power 
OFF button (O) or the On/Off power switch on 
the VÅNTEC-1 controller. The mains supplied to 
the system must be switched off externally.

Components attached to the goniometer will 
move during operation. Use proper lifting 
methods for the detector controller and the 
detector components.
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5.2 Shipping and Unpacking

1. Check for external shipping damage to the 
packages.

2. Open the boxes containing the detector and 
its components.

3. Check for any damage to the components.

4. Inventory all items for completeness.

5. Where possible, save the packaging for 
return shipping.

5.3 Baseline Data

Before doing any installations or calibrations on 
the diffractometer, run and save a standard 
Bragg-Brentano scintillation scan using the set-
tings in Table 7.1 or Table 7.2. The data file will 
be the baseline for comparison of the data col-
lected using the VÅNTEC-1 controller. The 
baseline data should be collected with a stan-
dard reference material (SRM) like the NIST 
1976 corundum plate (see the Instrument Verifi-
cation Booklet M88-Zxx041 for additional sys-
tem parameters).
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5.4 Hardware Installation

Use the following tools for this procedure:

• Loctite 422

• Torx screwdriver

• Allen screwdriver

Additional rails and hardware must be mounted 
to accommodate the VÅNTEC-1 controller and 
FDC (if present) in the D4. The location of the 
FDC (if present) and PSD controllers is critical 
for proper operation. There must be sufficient 
airflow around the controllers to prevent the 
electronics from overheating. Do not place the 
VÅNTEC-1 controller in close proximity to the 
generator. This may induce electronic noise in 
the detector electronics.

Use care when moving the detector head to 
avoid mechanical shock to the assembly.

See Table A.3 in Appendix A for the configura-
tion scheme.

5.4.1 Mount the Rails and Detector

1. Remove the D4’s left side panel.

2. Remove the rack for the electronics.

3. Mount the rails and attach the rack nuts at 
the positions shown in Figure 5.1. The FDC 
(if present) must be mounted below the 
detector controller. Otherwise, the airflow 
inside the detector controller is restricted.

Figure 5.1 - Mount the controllers in the electronics rack

4. Adjust the height of the rails so that the con-
troller can be fixed to the rack nuts.

5. Take out the controllers and mount the rack 
into the system again.
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6. Mount the controllers into the rack and con-
nect the components as shown in Figure 
4.3.

The cabling of the VÅNTEC-1 inside the radia-
tion safety box is shown in Figure 5.2 through 
Figure 5.4.

Figure 5.2 - Fix the spring to the ceiling with Loctite 422

Figure 5.3 - Fix the cables as shown
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Figure 5.4 - Fix the cables as shown

7. Fix the detector to the detector mount with 
two M3 countersunk screws and two M5 
Allen screws (see Figure 5.5).

8. Mount the high voltage cables to the strain 
relief (see Figure 5.6). Attach the other 
cables to the strain relief with cable ties.

Figure 5.5 - Mount the detector to the detector mount

Figure 5.6 - Strain relief

M3

M5

Strain 
relief
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9. To mount the detector, use M5 30 mm Torx 
screws and place the detector onto the 
goniometer. Use the same position as used 
with the secondary slit system with the scin-
tillation counter (see Figure 5.10).

Position additional components, such as the 
scintillation counter and slit systems, so that no 
cables or components can collide or jam with 
the sample lift.

5.4.2 Install the Primary Beam Stop

1. Remove the cover of the sample magazine 
and all side and back panels.

2. Mount the special handles for the front 
panel. Turn the safety key to position 1. 
Open the front panel.

3. Remove the scintillation counter, propor-
tional counter (Ca channel) or SOL-X detec-
tor and position the components so that 
they will not collide with other components.

4. Using Service Support mode, drive the sam-
ple lift to 200 mm.

5. Using Service Support mode, drive the 
detector to 100° 2-theta and the sample 
holder to 70° theta.

6. Mount the bracket for the magnet of the 
beam stop. Secure the slide for the beam 
stop using the screws and cable clamps as 
shown in Figure 5.7.

Figure 5.7 - Mount the bracket for the magnet of the 
beam stop

Bracket for 
magnet

Sample
lift

Screws and 
clamps
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7. Drive the sample holder to 30° and mount 
the beam stop for the D4 (see Figure 5.8). 
Place a T-nut into the groove ring of the 
goniometer and tighten the fixing screw. 
Ensure that the two additional pins also fit 
into the groove ring.

NOTE: Do not lose the T-nut in the groove—put 
a tissue into the groove to prevent this.

Figure 5.8 - Mount the primary beam stop

8. Screw the alignment screw completely out 
(see Figure 5.9). Put the alignment pin into 
the goniometer ring and place the beam 
stop so the alignment screw hits the align-
ment pin.

Figure 5.9 - Details of the primary beam stop—showing the 
extreme low position of the beam stop

Primary 
beam 
stop

Alignment 
screw

Linear 
guidance

Alignment 
pin

Fixing 
screw

Positioning 
pins
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9. Mount the actuator for the beam stop colli-
sion switch using a T-nut in the groove ring 
(see Figure 5.10). The position of the actua-
tor is defined by the extreme low position of 
the alignment screw and shows the highest 
position of the primary beam stop (about 6° 
2-theta).

Figure 5.9 shows the actuator in the 
extreme high position of the alignment 
screw.

Figure 5.10 - Mounting of the actuator bracket for beam stop 
collision switch

10. Mount the collision switch to the detector 
mount. Place the color-coded banana plugs 
into the sockets on the goniometer side 
panel labeled “Collision switch.” Do not 
switch the colored plugs and sockets (see 
Figure 5.11).

Figure 5.11 - Cabling of the collision switch

11. Connect the plug X672 to the cable for the 
switch monitoring in D4TOOLS.

Actuator/
bracket

Mount 
positions

Fixing of 
actuator

Plugs of 
collision 
switch

Connector for the 
switch monitor
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12. Mount the collision switch to the detector 
mount (see Figure 5.12). Use the top posi-
tion for mounting. Align the final position 
after attaching the detector to the goniome-
ter to make the switch contacts.

Figure 5.12 - Mount the collision switch to the detector 
mount

13. Test the collision switch by holding up the 
beam stop while moving down the detector 
(2-theta). The instrument must stop moving 
and display the error “theta and 2-theta in 
collision” after the collision switch hits the 
actuator bracket.

14. Connect the cable wiring as described in 
Section 4.4.3.

15. Follow Section 4.4.4, Section 4.8 and Sec-
tion 4.8.3 through Section 4.6.

16. Replace the left side panel on the controller 
rack.

17. To complete the installation, proceed to 
Section 6.
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6. Software Configuration

This section describes basic software configura-
tion.

Communications between the D8 controller, 
FDC (if present) and the detector are made via 
RS232 communication ports. Communications 
between the frame buffer computer and the 
detector controller are made via a network con-
nection. The parameters for communications 
must be defined by the user and are stored in 
the device.ini file. The Configuration program is 
used to set the parameters. Perform the follow-
ing steps to configure the system (see Figure 
4.3 for the cabling scheme for an internal FDC,  
Figure 4.6 for the cabling scheme for an inte-
grated FDC).

6.1 Recommendations

Software versions listed are minimum recom-
mended versions.

• D8 Controller Firmware 2.03

• D4 Controller Firmware 1.05

• PSDWare 0.51

• FPGA v1.01 AK (for external FDC)

• FPGA v1.02 AN (for internal FDC)

• DIFFRACplus Measuring Package

• VÅNTEC-1 Update Package

• Clock Signal Cable A17-D42

• Adapter for Clock Signal Cable A17-D43

NOTE: Never mix software packages/versions 
from VÅNTEC update CDs containing different 
releases!
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6.2 Configuration of the Second 
Network Adapter “LAN 2” in the 
PC

An additional network card is required if the cus-
tomer will be connecting to their LAN network. 
The second LAN connection is used to control 
the components needed by the detector.

1. Mount the additional PCI network adapter 
into a free PCI slot in the PC.

1.1 To install the network card, see Section 
4.6.

2. Restart the computer.

3. Windows should recognize the new hard-
ware. If it asks for a diskette that contains 
the network adapter driver, insert the instal-
lation CD.

4. Configure the network adapter.

4.1 Click Start > Settings > Control Panel 
> Network and Dial-up Connections.

4.2 The new network adapter is listed as 
“Local Area Connection 2.”

4.3 Right-click on the new adapter and 
select Properties. A new dialog box will 
appear (see Figure 6.1).

Figure 6.1 - Local Area Connection Properties
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4.4 Select the Internet Protocol (TCP/IP) 
item and click the Properties button. 
Another dialog box will appear (see Fig-
ure 6.2).

Figure 6.2 - Internet Protocol (TCP/IP) Properties

4.5 Select the “Use the following IP 
address” radio button and enter 
192.168.23.1 for the IP address and 
255.255.255.0 for the Subnet mask. 
Leave all other fields blank.

4.6 Confirm and close both dialog boxes by 
clicking OK in each box.

The frame buffer computer’s network adapter is 
now configured.
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6.3 Detector Software Configuration

1. Open the Configuration program (Con-
fig.exe) located in the C:\Diffplus directory.

1.1 From the main Config menu, select the 
Detectors menu (see Figure 6.3).

1.2 Check the Position Sensitive Detec-
tor checkbox.

1.3 Set the PSD type to VÅNTEC-1.

1.4 Select OK.

Figure 6.3 - Detector menu in Configuration program
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6.3.1 Software Configuration

From Config:

1. The FDC type has to be set to “internal”. In 
fact, the settings of the “Fast Diffraction 
Controller” at the subfolder “Computer 
Ports” will be inaccessible (see Figure 6.9).

2. Check whether the FDC entry at the “Com-
puter Ports” section is inactive.
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3. Select VÅNTEC-1 Setup (see Figure 6.4).

3.1 Select Default.

3.2 Set the Geometry Angle to 12°.

3.3 Set FDC type to Internal for detector 
controllers with an internal FDC (See 
Section 3.2.1 for identification).

3.4 Select FDC type to Socabim for detec-
tor controllers with an external FDC 
(See Section 3.2.1 for identification).

3.5 Click OK.

Figure 6.4 - Position Sensitive Detector menu

Figure 6.5 - Settings for FDC type
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6.4 Network Configuration

The Advanced Board Setup menu, located in 
the Configuration program, must be completed 
prior to saving and downloading the configura-
tion file.

1. Go to Advanced Board Setup > PSD-Con-
troller.

1.1 In Communication Topology, select 
Network and press the button Default 
Network Settings.

1.2 In Serial Communication Parameters, 
ensure that Determine Automatically 
is selected.

1.3 Click OK.

Figure 6.6 - PSD Controller menu
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2. Go to IP Setup and Services (see Figure 
6.7).

2.1 In IP Setup, select the Static Address 
Assignment radio button.

2.2 Enter the Host IP Address 192.168.23.2 
and the Netmask 255.255.255.0. Do 
not change any other values.

2.3 Under Services, check the HTTP Inter-
face checkbox.

2.4 Click OK.

2.5 If no Users are available, refer to 
Appendix C.1.

Figure 6.7 - IP setup
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6.5 Computer Port Configuration

6.5.1 For detector controllers with external 
FDC

1. In Config, go to Computer Ports (see Figure 
6.8).

Figure 6.8 - Computer port configuration

6.5.2 For detector controllers with inte-
grated FDC

1. In Config, go to Computer Ports (see Figure 
6.9).

Figure 6.9 - Settings for computer ports
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6.5.3 Set Up Communication Parameters 
(both FDC types)

Under Diffractometer, select Settings.

1.1 In the pop-up window, select TCP/IP as 
the connection type.

1.2 Enter the IP address 192.168.23.2 and 
the port 4251.

1.3 Click OK and close the window.

Figure 6.10 - Diffractometer > Settings pop-up window

2. In Computer Ports, select Settings under 
PSD Controller.

2.1 In the pop-up window, under TCP/IP, 
enter the IP address 192.168.23.2 and 
the port 4250.

2.2 Click OK and close the window.

Figure 6.11 - PSD Controller > Settings pop-up window

3. In Computer Port Configuration, click OK to 
accept the changes (see Figure 6.8).

4. To activate the configuration, go to File > 
Save and Download or click the CNF icon.
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5. In the Save and Download pop-up window, 
ensure that all boxes are checked.

Figure 6.12 - Save and Download pop-up window

6. Check that the VÅNTEC-1 controller, the 
FDC (if present) and the diffractometer are 
switched on and connected according to 
Figure 4.3. If your VÅNTEC-1 has an inte-
grated FDC, refer to Figure 4.6.

7. Click OK to download.

6.6 Factory Default Settings

1. Import the default detector settings (see Fig-
ure 6.13).

1.1 In the Configuration menu, select File > 
Section(s) > Import ... .

1.2 Import the Advanced Settings from the 
floppy disk sent with the controller. The 
floppy will be marked “Advanced Set-
tings” with the system serial and control 
numbers. Advanced settings imports all 
of the factory-determined specifica-
tions into the configuration file.

Figure 6.13 - Import detector settings
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2. Select VÅNTEC-1 Setup (see Figure 6.14).

2.1 Set the Geometry Angle to 12°.

2.2 The starting values for Resolution and 
Zero Offset should be 0.008 and -6.5, 
respectively.

2.3 Click OK.

Figure 6.14 - VÅNTEC-1 Setup menu
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7. Calibration

Prior to calibration, the system must be aligned 
using the scintillation detector.

Each detector and the associated electronics 
are unique. A calibration process is used in con-
junction with standard reference materials to 
determine a zero offset for the resolution in 
degrees. This value represents the angular dif-
ference between the zero angle of 2-theta and 
the zero channel of the PSD. The calibration 
program will refine the values and record them 
in the Configuration program.

7.1 Positional Calibration

1. Manually open all window slits as wide as 
possible.

2. Ensure that the proper Kβ filter is in place.

3. Make sure that no Debye slit is in place.

4. Ensure that the reference material is 
mounted (quartz or NIST 1976) in the sam-
ple stage.

5. Set the goniometer to the parameters in 
Table 7.1 or Table 7.2 using DIFFRACplus 
COMMANDER.

NOTE: Do not close DIFFRACplus COM-
MANDER. Instead, minimize the window.
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Table 7.1 – Parameters for Quartz standard reference

Table 7.2 – Parameters for NIST 1976 standard reference

Goniometer Divergent slit Generator 
settings

Scan 
parameters

Scan speed

Radiation Theta/Theta Theta/2-theta Variable Fixed 
(mm)

Kβ filter kV mA Increment PSD 
(sec)

Scintillation 
(step/sec)

Cr 20.03 20.03 20.03 40.06 0.3° 0.6 V 35 45 .006 30 .002

Co 15.52 15.52 15.52 31.04 0.3° 0.6 Fe 35 45 .006 30 .002

Cu 13.32 13.32 13.32 26.64 0.3° 0.6 Ni 40 40 .006 30 .002

Goniometer Divergent slit Generator 
settings

Scan 
parameters

Scan speed

Radiation Theta/Theta Theta/2-theta Variable Fixed 
(mm)

Kβ filter kV mA Increment PSD 
(sec)

Scintillation 
(step/sec)

Cr 26.67 26.67 26.67 53.34 0.3° 0.6 V 35 45 .006 30 .002

Co 20.52 20.52 20.52 41.05 0.3° 0.6 Fe 35 45 .006 30 .002

Cu 17.57 17.57 17.57 35.15 0.3° 0.6 Ni 40 40 .006 30 .002
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7.2 PSD Calibration

7.2.1 Create Files

1. Open XRD Wizard from C:\Diffplus\XRD-
Wizard.exe.

2. Select File and New to display the file types 
available. This window creates the DQL 
used for calibration.

3. Select PSDCalib from the new menu files. 
Click OK (see Figure 7.1).

Figure 7.1 - Wizard > File > New

4. To create the DQL file, input the calibration 
parameters and click OK. The number of 
positions must be nine or greater. When-
ever possible, select rotation ON and set 
the speed at 15 rpm.

5. Determine the theoretical 2-theta values 
using Table 7.1 and Table 7.2. Input the val-
ues into the Calibration Parameters screen 
(see Figure 7.2).

6. Input a step size of 1.

7. Save the DQL file as Calib.DQL and exit 
XRD Wizard.



Calibration VÅNTEC-1 Detector User Manual

7 - 4 M88-E01072

Figure 7.2 - Create the DQL file. Example shown is for Corundum sample and Cu radiation.
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7.2.2 Collect Data

1. Open DIFFRACplus COMMANDER.

2. Select the Jobs tab and create a job using 
the Calib.DQL file.

3. Name the RAW file Calib.raw.

4. Press Start Job and wait for the job to fin-
ish.

NOTE:  If desired, you can save this job for 
future calibrations.
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7.2.3 Analyze Data

1. After creating Calib.raw, select Analyze 
Calibration in the Configuration program 
under the VÅNTEC-1 Setup menu (see Fig-
ure 7.3).

Figure 7.3 - Analyze the calibration
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2. Use the Browse button to locate the RAW 
file saved during the calib.job measurement 
(see Figure 7.4).

Figure 7.4 - Locate the RAW file

3. Press Apply to analyze the calibration and 
set the resolution and offset of the detector.

4. Ensure that the mode zero offset value is 
approximately -5 to -8. Resolution should be 
approximately .007.

5. Recalibrate if the standard deviation is 
greater than 0.05°. Continue on to the next 
step when you have reached a standard 
deviation of less than 0.05° (i.e., zero offset 
is approximately -5 to -8 and standard devi-
ation is less than 0.05).

6. After changing the detector parameters, 
save and download the new configuration.

The calibration is now complete.

After analyzing the calibration file and prior to 
executing a measurement, optimize the detector 
optics using the Calculate Geometry menu in 
the VÅNTEC-1 Setup menu (see “Calculate the 
Optimum Secondary Slit Openings” in Section 
9.7).

NOTE: Whenever changes have been made in 
Config, remember to restart the Measurement 
server!
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8. Alignment

Peak position is determined during calibration 
(see Section 7), not during alignment. The align-
ment optimizes the resolution of the detector. 
The resolution is determined by finding the best 
possible FWHM (Full Width Half Maximum). The 
resolution is dependent on the measuring circle 
and the alignment of the detector mount.

8.1 Alignment of the VÅNTEC-1 
Detector and Mount

Complete a coarse alignment of the 2 DOF 
mount by running repeated PSD fixed scans of 
NIST SRM 1976 or Quartz. For a quick assess-
ment of the alignment, compare the intensities 
of the main (104) peak to the valley between 
Kα1 and Kα2 (see the example in Figure 8.1). 
[Example: The first scan’s intensity of the valley 
is 4,000 cps. The main peak’s intensity is 8,000 
cps. This represents a ratio of 2 (4,000:8,000 = 
1:2)]. A ratio of 3.0 to 4.0 is desired. Once the 
max ratio is achieved, proceed to Section 8.2.

1. Run a PSD fixed scan. Use a standard ref-
erence material of the NIST SRM 1976 
Corundum plate (104) or Quartz (101) 
reflection. Use the parameters in Table 8.1 
for SRM 1976.
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For additional information on running a mea-
surement, see Section 9.

NOTE: The detector must be set in the Details 
tab of DIFFRACplus COMMANDER before 
selecting fixed PSD scan.

2. After running the baseline scan, measure 
the ratio of the intensity of the main peak to 
the valley between the Kα1 and Kα2 peaks 
(see Figure 8.1).

NOTE: The increment is dependent on PSD-
Calib and the measuring diameter.

Figure 8.1 - Measure the intensity ratio

Start 33.6°

Stop 36.6°

Increment 0.006°

Scan type Fixed PSD

Near window slits Open

Detector window slits Open

Soller slit 2.5°

Ni filter In

Debye slit Out

Scan speed 30 sec. per step

Table 8.1 – Scan parameters for SRM 1976

Kα1

Kα2

First scan

Second scan

Third scan
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3. Adjust the yaw “Y” of the 2 DOF. The yaw 
adjustment uses opposing screws. To make 
an adjustment, first loosen the opposing 
screw and then tighten the adjusting screw 
(see Figure 8.2).

Figure 8.2 - Yaw “Y” and roll “Z” adjustments

4. Re-run the scan and compare the ratio to 
the baseline scan. If the ratio increases, 
continue to adjust in the direction first 
attempted. If the ratio decreases, reverse 
the direction of movement and repeat step 3 
until the maximum ratio is achieved. Use the 
ratio to check the alignment. Intensity of the 
valley alone may vary.

5. Repeat step 3 and step 4 for the roll “Z” of 
the 2 DOF until a ratio of 3.5 to 4.0 is 
achieved. Noticeable separation can be 
seen between the Kα1 and Kα2 peaks when 
alignment is correct. Save the final scan for 
future reference.

 roll “Z”
 yaw “Y”
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8.2 Evaluation and Data 
Interpretation

Alignment is complete when FWHM matches 
the specifications in Table 8.2. The FWHM (res-
olution) is determined using the AREA feature of 
the program DIFFRACplus EVA, which is part of 
the DIFFRACplus Basic package supplied with 
the diffraction system. To learn how to use EVA 
and its AREA function, refer to the DIFFRACplus 
EVA User Manual (M85-Exx002). Check the 
alignment if the detector is removed or moved to 
another measuring circle. If specifications are 
not met, repeat Section 8.1.

Table 8.2 – FWHM specifications for Cu radiation

1. Start EVA and load the RAW data to evalu-
ate.

2. Open the EVA toolbox (press F2 or the 
hammer icon) to perform background sub-
traction and a Kα2 stripping, ensuring a 
properly adjusted Kα1/Kα2 ratio to minimize 
artifacts and a 0.5 intensity ratio. Select the 
Append button to create a new phase.

3. Use the Area function in the EVA toolbox to 
create an area measurement using the 
complete measured range (see Figure 8.3). 
Use the mouse to select the range.

 

Figure 8.3 - Complete measured range

Cu Bragg Göbel Mirror

401 mm < 0.065° < 0.130°

435 mm < 0.060° < 0.120°

500 mm < 0.055° < 0.110°

600 mm < 0.055° < 0.110°
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4. Review the data displayed in Toolbox (see 
Figure 8.4). Alignment is complete when 
FWHM matches the specifications in Table 
8.2.

Figure 8.4 - EVA toolbox

5. After completing the alignment of the mount, 
repeat the calibration described in Section 
7.

NOTE: The primary installation and IQ OQ PQ 
(part number M88-Exx068) may require addi-
tional testing instrument verification.
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9. Basic Operation

This section covers the power-up, power-down, 
and basic operation procedures for the VÅN-
TEC-1 detector system and gives an overview 
of system operation and collection of data. 
Operation details for XRD COMMANDER are 
described in the document M88-Exx060.

The Stop button will not turn off the three AC 
outlets (X601) that are located on the mains 
distribution panel! Devices connected to these 
AC outlets can only be switched off by the 
internal automatic circuit breaker labelled F600 
or the external power switch that is installed on 
the user’s side close to the diffractometer.

The VÅNTEC-1 controller requires one hour to 
warm up for optimal results.

9.1 VÅNTEC-1 Power-Up Procedure

1. Press the I/O button on the front of the VÅN-
TEC-1 controller to apply mains power. The 
I/O button illuminates when power is 
present. If the I/O button doesn’t illuminate, 
ensure that there is power applied to the D8 
system by pressing the Power ON ( I ) but-
ton located on the right side column of the 
D8 enclosure.

2. Turn on the high voltage for the detector by 
pressing the high voltage enable button on 
the front of the VÅNTEC-1 controller. If 
power and communications for the control-
ler are properly applied, there should be no 
warning LED illuminated. The system LED 
will flash, indicating communication and 
control. The high voltage LED will be yellow 
and illuminated. The low voltage LED will be 
green and illuminated.
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9.2 VÅNTEC-1 Power-Down 
Procedure

1. Press the high voltage enable button on the 
front of the VÅNTEC-1 controller. If the high 
voltage button is not illuminated, this indi-
cates that high voltage for the detector is 
OFF.

2. Press the I/O button on the front of the VÅN-
TEC-1 controller to switch off the mains 
power.

Wait 60 seconds after turning off HV power 
before removing the HV connectors!

3. Press the Power OFF button (O) on the D8 
enclosure’s right-hand column to stop 
power to the control electronics, high volt-
age generator, and the VÅNTEC-1 control-
ler and FDC (if present), when the 
controllers are connected to X602.

4. Before switching off the diffraction system, 
reduce the high voltage and current of the 
generator to the lowest values (e.g., 20 kV/
5 mA) using the control software (e.g., XRD 
COMMANDER).

5. Turn off the high voltage generator by turn-
ing the rotary switch “High Voltage” to the 
left side. The X-RAY ON displays will turn 
off.

6. Switch off the instrument by pressing the 
enclosure’s Power OFF button.

Failure to reduce the generator high voltage and 
current prior to shutting off the D8 could 
significantly reduce the lifetime of the X-ray tube 
and the high voltage generator.
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9.3 Emergency Power-Down 
Procedure

The mains power for the VÅNTEC-1 controller is 
connected to X601, located on the left side of 
the D8 lower enclosure.

1. In the event of an emergency, press either 
Stop button located on the front side col-
umns to switch off power to the control elec-
tronics, high voltage generator, and the 
VÅNTEC-1 controller and FDC (if present), 
when the controllers are connected to X602.

Use the Stop button to immediately shut off 
power to the X-ray source and stop all mov-
ing drives instantly. The Stop button should 
only be used in emergency situations and 
not for normal shutdown of the diffractome-
ter system.

The Stop button will not turn off the three AC 
outlets (X601) that are located on the mains 
distribution panel! Devices connected to these 
AC outlets can only be switched off by the 
internal automatic circuit breaker labelled F600 
or the external power switch that is installed on 
the user’s side close to the diffractometer. The 
control panels of the D8 diffraction system are 
located on the front side of the system. X602 is 
supplied power as long as the D8 On/Off switch 
(on the right-hand column of the D8 cabinet) is 
enabled and the two emergency Stop switches 
are not engaged.

2. To disengage the Stop button, turn the but-
ton clockwise and release. Re-apply power 
with the Power On button that is on the right 
side column of the D8 enclosure.
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9.4 Disconnecting the Power Plug

To remove, relocate or service the detector con-
troller, it may be necessary to disconnect the 
power cord from the rear of the controller.

1. Ensure that all power is off to the enclosure 
prior to removing the power cord.

2. Remove the rear access panel of the D8 
enclosure. Use caution when removing the 
panel as the ventilation fans are connected 
to it.

3. Visually inspect the power cord for frayed or 
exposed wiring prior to removal. If the 
power cord appears defective, contact 
Bruker AXS Service for replacement by 
qualified service personnel.

4. With the access panel removed, firmly 
grasp the power cord of the detector con-
troller at the strain relief and pull the cord 
from the controller.

5. The power cord is connected to X601 on the 
left side of the D8 enclosure. Pull the plug 
from this outlet strip.

9.5 Lock Out

1. Use the key located on the left side column 
of the D8 enclosure to lock and unlock the 
system.

During normal operation, the key must be 
switched to the unlocked position. In the 
unlocked position, power may be applied with 
the ON button located on the right-hand column 
of the D8 enclosure. In the locked position, no 
power will be available for the control electron-
ics, generator or X602 connectors. The key can 
only be removed in the locked position.

Power will still be present at the X601 
connectors. Electric shock can result if proper 
safety precautions are not observed.
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9.6 Performing a Measurement

XRD COMMANDER is the main measurement 
program in the DIFFRACplus suite. It can be used 
to perform immediate measurements to get a 
quick overview of a sample, as well as to per-
form batch measurements using jobs. Operation 
details for XRD COMMANDER are described in 
the DIFFRACplus COMMANDER User Manual 
(M88-Exx060). This section gives an overview 
of the system operation and collection of data.

To open the XRD COMMANDER program:

1. Locate the C:\diffplus directory.

2. Double-click on the XRDCMD icon. There 
may be icons set up on the desktop to open 
the XRD COMMANDER program, as well 
as in the DIFFRACplus Measurement folder 
in the Windows Programs menu.

9.6.1 Select the Detector Type

The XRD COMMANDER program window is 
separated into five pages.

1. Use the tabs on the bottom of the screen to 
change the active page (see Figure 9.1).

2. Select detector type PSD (VÅNTEC-1) in 
the Details tab.

Figure 9.1 - Tab selection
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9.6.2 Select the Scan Parameters

The following parameters must be selected prior 
to running a measurement: scan type, start, 
stop, speed, and increment (see Figure 9.2). 
Additional settings may include divergence slit 
size, rotation of the stage, and generator set-
tings for KV and mA.

When using a Fixed PSD scan, max length may 
vary and is dependent upon the Config geome-
try angle. 

To perform a measurement:

1. Turn the X-ray generator on.

Figure 9.2 shows the location of the parameters 
for immediate measurement. The fields show 
the actual settings for the current measurement.

Figure 9.2 - The scan control area

2. Scan type: Choose the scan type from the 
drop-down menu. You must select PSD as 
a detector type in the Details tab before 
PSD Fixed scan is available.

3. Scan speed: Enter the scan speed here. 
VÅNTEC-1 operation uses seconds per 
step. Click the button to the right of the input 
field to switch between seconds per step 
and degrees per minute. The actual setting 
will be displayed on the button.

4. Continuous/Step scan: Click this button to 
change between continuous or step scan 
mode. The actual setting will be displayed 
on the button. It is recommended that con-
tinuous scan be used to reduce wear on the 
goniometer.

5. Start, Stop: Use these buttons to begin or 
end an immediate measurement.

0.006
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9.6.3 Suppression of Kβ

During typical operation, suppression of Kβ is 
necessary. For this reason, it is important to 
make sure that you are using the proper filter. 
See Table 9.1 for proper filter selection and the 
location of the Kβ1 peak. In the case of Cu radia-
tion, a Ni filter is included with the VÅNTEC-1 
accessories.

Settings:

Quartz Standard

Anode E (KeV) Kα1 Kα2 Kβ1 Beta Filter

Cu 8.048 26.64° 26.70° 24.033° Ni

Cr 5.412 40.06° 40.13° 36.333° V

Co 6.92 31.04° 31.11° 28.054° Fe

Mo 17.44 12.17° 12.24° 10.852° Zr

Fe 6.40 33.67° 30.46° Mn

NIST 1976 Corundum Standard

Cu 8.048 35.15° 35.21° 31.673° Ni

Co 6.92 41.05° 41.11° 37.047° Fe

Table 9.1 – Filter selection and location of Kβ1 peak
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9.6.4 Secondary Optics Settings

In addition to selecting the proper filter, it is nec-
essary to fix the secondary slits of the VÅNTEC-
1 optics.

1. During the calibration of the detector, open 
both secondary slits to the maximum set-
ting. The position of the secondary slits is 
calculated for optimum performance under 
normal data collection operations (see Sec-
tion 9.7). An 8 mm Debye slit and 2.5° Soller 
slit will provide sufficient resolution for most 
measurements.

2. Manually close the anti-scatter slits to eight 
ticks up and eight ticks down for a total 
opening of 16 mm.

3. Manually close the detector window slits to 
ten ticks up and ten ticks down for a total 
opening of 20 mm.

9.6.5 Execute an Immediate Measurement

1. After selecting the correct scan parameters, 
click the Start button to begin the scan.

For more detailed information on the operation 
and use of the XRD COMMANDER measure-
ment software package, refer to the               
DIFFRACplus COMMANDER User Manual (M88-
Exx060).

9.7 Calculate the Optimum 
Secondary Slit Openings

This section describes how to calculate the opti-
mum setting for the secondary slits using VÅN-
TEC-1 Setup > Calculate Geometry in the 
Configuration program.

1. In the VÅNTEC-1 Setup menu, click the 
Calculate Geometry button. The PSD Cal-
culator menu will appear (see Figure 9.4).

2. Enter the goniometer diameter, divergence 
slit size, and the PSD angle from other 
menus in the configuration program to cal-
culate the optimum secondary slit and limits 
for the FDC fast scans. The values cannot 
be changed in this menu. They must be 
changed in their respective menus:

• The measurement diameter is set in the 
Basic Diffractometer Settings menu;

• The divergence slit size is set in the Fixed 
Beam Optics menu (see Figure ); and

• The PSD angle is set in the VÅNTEC-1 
Setup menu.

The calculation is made based on the diameter 
of the measuring circle (mm), size of the diver-
gence slit (mm), and the distance of the anti-
scatter and detector slits.



VÅNTEC-1 Detector User Manual Basic Operation

M88-E01072 9 - 9

Figure 9.3 - Fixed beam optics

The distance of the anti-scatter slit is measured 
from the center of the goniometer to the edge of 
the slits.

The distance for the detector slit is measured 
from the reference mark on the detector to the 
edge of the detector slits (see Figure 4.23).

The PSD resolution and offset were determined 
during the calibration of the detector.
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Figure 9.4 - PSD Calculator

3. Specify the optimum settings of the PSD 
angle or the detector slit width.

4. Physically set the slit settings to the values 
determined in step 3.

5. To implement the settings, press the Apply 
button.

6. Download the changes to the VÅNTEC-1 
controller to make them effective.

For more detailed information on the operation 
and use of the XRD COMMANDER measure-
ment software, refer to the DIFFRACplus COM-
MANDER User Manual (M88-Exx060).
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10. Preventive Maintenance and 
Troubleshooting

The components of the diffractometer measur-
ing equipment are maintenance-free for the 
user. However, Bruker AXS recommends a 
yearly preventive maintenance inspection. To 
schedule this inspection or for technical support, 
contact your local Bruker AXS Service Depart-
ment (for the U.S.A., call 1-800-234-XRAY). 
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10.1 Cleaning the Diffraction System 
and Measuring Equipment

Before cleaning the equipment, turn off power to 
the complete diffraction system (i.e., all control 
electronics, accessory components, and the 
high voltage generator).

Do not touch the front window of the X-ray 
detector and the X-ray tube as they contain 
beryllium. Beryllium is potentially hazardous if 
ingested, inhaled or absorbed through the skin. 
Take care to avoid contact with the VÅNTEC-1 
X-ray window. Never drill, grind or sand 
beryllium unless you are a qualified individual 
using appropriate respiratory equipment and 
dust containment and collection apparatus. 
Disposal of parts containing beryllium must 
comply with all applicable national regulations.

To clean the interior of the enclosure and exte-
rior of the detector components, use dry clean-
ing utensils only. Do not use water or 
aggressive cleaning agents. Clean laboratory 
conditions are recommended.

Airflow is critical for maintaining proper opera-
tion of the detector control electronics. Do not 
place anything on the controllers that may 
restrict the flow of air. Regular cleaning of the 
detector components includes removal of any 
airflow restrictions, including dust.
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10.2 Replacing Fuses

1. Unplug the power cord before replacing the 
fuse.

2. Locate the fuse.

3. Carefully remove the fuse from its holder. 
You may need a small screwdriver or nee-
dle-nose pliers to pry open the fuse cover 
(see Figure 10.1).

NOTE: Replace the fuse only with the specified 
replacement (see Appendix B). Do not substi-
tute a fuse with a different rating.

4. Insert the new fuse into the holder. Verify 
complete seating of the new fuse.

5. Replace the fuse cover.

6. Plug in the power cord.

If the controller continues to blow fuses or if any 
function does not work correctly after replacing 
the fuse, contact Bruker AXS Service for repair 
assistance. Discontinue use of the controller if it 
is not functioning properly.

Figure 10.1 - Fuse close-up
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10.3 Troubleshooting

1. Display data in the XRD COMMANDER 
window has flatlined or is nonexistent.

• Ensure that the detector type VÅNTEC-1 
PSD is selected in the Details tab of the 
COMMANDER program.

• Ensure that the detector setting matches the 
factory setting and the setting in the Config 
program.

Set the detector to the factory setting using 
the Set Detector button.

Update the config file.

1.1 If external FDC is used, is data now 
present on the FDC controller display?

If the FDC displays data, check the inter-
connect cables.

If the FDC does not display data, check if 
the HV Enable button is illuminated.

2. The High Voltage Enable button is not 
illuminated.

• Press the High Voltage Enable button.

If the switch lights, the high voltage is 
enabled.

If the switch is still not lit, check the Power 
ON switch on the VÅNTEC-1 controller or 
D8 enclosure.

• Use a continuity checker or ohmmeter to 
verify the condition of the fuse. Visual 
inspection is not a reliable method for deter-
mining the fuse condition. If you do not have 
access to one of the above instruments, 
replace the suspect fuse with a new fuse.

3. There is no communication to the sys-
tem and the following error appears: 
“Time Out Reading from Socket.”

• Check the network cable connections and 
network card.

• Check the network setting in the Config pro-
gram file.

• Connect a serial cable and attempt to 
recover communications from the Config 
program (see Section 6.5).
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4. The angular accuracy peak position data 
is greater than +0.01° of the expected 
value.

• Repeat the calibration of the VÅNTEC-1 
detector (see Section 7).

5. There is poor instrument resolution 
(FWHM is greater than 0.065° of the 104 
reflection of NIST 1976).

• Repeat the alignment of the 2 DOF mount 
for the VÅNTEC-1 detector (see Section 8).

6. The following error appears: “Scan Out-
side Software Limits.”

• Using Fixed Scan mode, the start-to-stop 
range is determined by the configuration 
and cannot exceed the geometry angle set 
in Config (max 12°).
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10.4 Manual Configuration of the 
Controller

If there is no communication to the D8 control-
ler, power-up the VÅNTEC-1 controller using 
the following procedure.

1. In the Config software, go to PSD-Control-
ler. Press the “Recover…” button located in 
the lower left corner of the window (see Fig-
ure 6.6). A new window will pop up (see Fig-
ure 10.2).

Figure 10.2 - Recover... pop-up window

2. Follow the steps in the screen shown in Fig-
ure 10.2.

3. Select COM1 in the drop-down list and 
press Continue. Another window appears 
indicating that Config is now waiting for the 
controller to boot up.

Figure 10.3 - Boot-up window

4. Switch on the controller and wait a few min-
utes. As soon as the controller becomes 
ready, Config transmits the configuration 
file.

5. A message will pop up stating that transmis-
sion is successful. Switch off the VÅNTEC-1 
controller.

6. Replace the cables as they were prior to this 
recovery procedure (see Figure 4.3 for 
external FDC configurations, Figure 4.6 for 
integrated FDC configurations).

7. Switch on the VÅNTEC-1 controller.

Communication is now via the LAN line.
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Appendix A. Configuration Tables

Measurement 
Diameter (mm)

Standard 
Sample 
Stage

Rotation 
Sample 
Stages

Non-Ambient 
Chambers

Reflectometry 
Sample Stage

Flip Stick Centric 
Eulerian 
Cradle

D4
Sample 
Stages

401 – – – – – – A17-D16

435 A17-D15 A17-D15 A17-D15 A17-D15 – – –

500 A17-D17 A17-D17 A17-D17 A17-D17 – – –

500 A17-D18 A17-D18 A17-D18 A17-D18 A17-D18 A17-D18 –

Table A.1 – Part number configuration for the radial Soller slit assembly
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Part Number A17-D15 A17-D16 A17-D17 A17-D18

Name Radial Soller 
VÅNTEC-1 435 mm

Radial Soller 
VÅNTEC-1 401 mm

Radial Soller 
VÅNTEC-1 500 mm

Radial Soller 
VÅNTEC-1 Push-Plug

Available Space 
to Sample Center

82.5 mm 82.5 mm 82.5 mm 132 mm

Table A.2 – Part number breakdown for the radial Soller slit
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The air scatter screen is available only for the 
following components and configurations. If your 
Göbel mirror housings are older than August 
2004, they have to be upgraded with part num-
ber A18-C201. Contact Bruker AXS Technical 
Support for more information.

Measuring 
Diameter 
(mm)

Primary Optics Fixed  
Sample 
Stage 
Reflection

Rotation 
Sample Stage 
Transmission 
(Reflection 
mode)

Rotation 
Sample Stage 
Transmission 
(Transmission 
mode)

Flip Stick 
(9 position)

D4 Sample
Stage

401 Fixed or variable 
slits

– – – – A17-B27

435 Fixed or variable 
slits

A17-B28 A17-B28 A17-B28 A17-B28 –

435 Göbel mirror 
40 mm

A17-B27 A17-B27 A17-B27 A17-B27 –

500 Fixed or variable 
slits

A17-B29 A17-B29 A17-B29 A17-B29 –

500 Göbel mirror 
60 mm

A17-B28 A17-B28 A17-B28 A17-B28 –

500 Push-Plug (slits 
and Göbel mirror)

A17-D1 A17-D1 A17-D1 A17-D1 –

Table A.3 – Configuration scheme for the air scatter screen
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Appendix B. Spare Parts List

Part Number Description

033-007300 House Dress Cover 1D

070-003200 Fuse: F, 3.15 A, 250 V, 5 x 20 mm

072-000400 Fan, 12 V Rotron

085-000200 Coaxial thin wire cable

085-006100 3 cond. 8'2" cable

085-013500 Push button 0/1 switch

085-013800 Cable control to FDC

113-002400 Power supply ATX ACE-81

222-224300 Flash drive

222-244100 PCI backplane

222-244200 Comp PCI single board (SBC)

Table B.1 – Spare parts
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419-308900 PCB TDC

419-309601 PCB CFD

419-309701 PCB preamp 1DDL

419-309901 PCB preamp grid

472-051600 Pressure vessel 1D

472-052500 Filter assembly 1D

472-053000 HV filter chassis

472-053600 Mount Assy/D4 106mm/ PXC, 1D

472-053700 LV Power Supply/Chassis

672-012200 Detector assembly

672-012600 Controller 1D

7KP2912-8BA Fast Diffraction Controller

842-082100 VÅNTEC-1 Detector, 1D

A17B10 Optic for VÅNTEC-1

A17B13 Set of Kβ radiation (Cr, Co, Mo radiation)

A17B14 Short anti-scatter slit assembly (401 mm measurement circle)

A17B15 Long anti-scatter slit assembly (435 mm measurement circle)

A17B16 Debye slit 8 mm

Part Number Description

Table B.1 – Spare parts
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A17B17 Debye slit 4 mm

A17B18 Ni filter for Cu-Kβ radiation for VÅNTEC-1 (high overall intensity), 2.5%

A17B19 Debye slit 1 mm

A17B20 Fe filter for Co-Kβ radiation for VÅNTEC-1

A17B21 V filter for Cr-Kβ radiation for VÅNTEC-1

A17B22 Zr filter for Mo-Kβ radiation for VÅNTEC-1

A17B23 Ni filter for low Cu-Kβ radiation for VÅNTEC-1 (default), 0.5%

A17B25 Soller slit 2.5° for VÅNTEC-1

A17B26 Soller slit 4° for VÅNTEC-1

A17B27 Air scatter screen, 401 mm diameter

A17B28 Air scatter screen, 435 mm diameter

A17B29 Air scatter screen, 500 mm diameter

A17B30 Beam Stop for D8 (150 mm goniometer height)

A17B31 Long anti-scatter slit assembly (500 mm measurement circle)

A17B32 Beam Stop for D4

A17B35 Mount for VÅNTEC-1, measurement height 150 mm

A17B36 Mount for VÅNTEC-1, measurement height 214 mm

A17B37 Mount for VÅNTEC-1, measurement height 258 mm

Part Number Description

Table B.1 – Spare parts
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A17B71 Fluorescent screen

A17C84 Beam Stop adapter for VÅNTEC-1 Mount

A17C89 Beam Stop extension D8 to 214/258 mm goniometer height

A17D1 Air Scatter screen, Push-plug

A17D10 VÅNTEC-1 Detector for D8 ADVANCE/D8 DISCOVER, Including Beam 
Stop for External FDC

A17D11 VÅNTEC-1 Detector for D4 ENDEAVOR, Including Beam Stop and Mount 
for External FDC

A17D12 Set of Debye Slits For VÅNTEC-1 Detector (1 mm, 4 mm And 8 mm)

A17D13 Set of Kβ-filters for VÅNTEC-1 (Cr, Co and Mo radiation)

A17D15 Radial Soller Slit for VÅNTEC-1 (435 mm measurement circle)

A17D16 Radial Soller Slit for VÅNTEC-1 (401 mm measurement circle)

A17D17 Radial Soller Slit for VÅNTEC-1 (500 mm measurement circle)

A17D18 Radial Soller Slit for VÅNTEC-1 (Push-plug)

A17D40 VÅNTEC-1 Detector with Internal FDC For D8, Including Beam Stop

A17D41 VÅNTEC-1 Detector with Internal FDC for D4 ENDEAVOR, including 
Beam Stop and Mount

A17-D42 Clock Signal cable

A17-D43 Y-shaped Adapter Cable for first-generation indexer boards

A18-C201 Soller holder for Göbel mirror

Part Number Description

Table B.1 – Spare parts



VÅNTEC-1 Detector User Manual Appendix B: Spare Parts List

M88-E01072 B - 5

C71121Z253F41 Nut/cage M6

C72195Z122K2 Socket

C72195Z122K3 Cable Fixer

C72298A251B39 Ground Cable for FC (S3K)

C79298A3130A76 Cable Serial Communication Control PC to Detector Controller

C79298A3220B240 TDC Signal Conditioning board

C79298A3320B124 Remote Control board

K340C9 Ethernet Crosslink cable 50 Ft (15 M)

K360C2 Network card

N120C47 ISO 14583 M5x30 8.8

N120C51 Screw head M6x16 ISO 14583

N301C14 EN 27090 A5

N301C15 EN 27090 A6

Part Number Description

Table B.1 – Spare parts
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Appendix C. Updating the Detector 
Controller Firmware

The Bruker AXS VÅNTEC-1 detector controller 
is running Linux as its embedded operating sys-
tem. The operating system itself and all associ-
ated control software is stored on a Flash drive 
inside the controller. This section describes how 
to update the firmware on the detector control-
ler’s Flash drive.

C.1  Setting up the HTTP connection

To access the detector controller with a Web 
browser, the user needs a login name and pass-
word. 

To set up the login and password:

1. Open the Diffractometer Configuration pro-
gram and go to Basic Diffractometer Set-
tings > Advanced Board Setup > PSD-
Controller > IP Setup and Services. 
Check the HTTP Interface checkbox and 
press the Users button.
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Figure C.1 - Set up login and password
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2. Click Add User.

Figure C.2 - List of HTTP Users menu

3. Fill in the fields in the Add User window as 
follows:

User: user

New Password: DIFFRAC (for example)

Type your new password again in the “Confirm 
Password” field.

Check the Status and Service checkboxes.

Figure C.3 - User and password setup under Add User 
menu

4. Click OK.

5. Save and download the configuration.

From the menu bar at the top of the Diffractome-
ter Configuration window, go to File > Save and 
Download.

6. A confirmation window appears (Figure 
C.4). Click Yes.

Figure C.4 - Save changes confirmation window

7. Upon saving, the software intelligently 
decides whether it needs to download the 
configuration information to the diffractome-
ter. A window appears showing whether the 
software will do this or not (in Figure C.5, 
the configuration will not download). Accept 
the default and click OK.

Figure C.5 - Download configuration window
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C.2  Performing the Flash Disk Instal-
lation

In order to update the embedded Linux system 
on the Flash drive, do the following:

1. Open your preferred Web browser.

2. Browse the x86 based CPU-Board or PC by 
typing the detector controller’s IP address 
into the address field of your browser:

http://192.168.23.2

NOTE: If you are using a local proxy server, 
make sure the detector controller’s IP address is 
excluded by entering it as an exception in your 
Web browser’s Proxy Settings menu. For Inter-
net Explorer, go to Internet Explorer > Tools > 
Internet Options > Connections > LAN Set-
tings > Advanced. See Figure C.6.

Figure C.6 - Entering the detector controller’s IP address as 
a Proxy server exception
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3. After typing the detector controller’s IP 
address, hit Enter. The detector controller 
prompts you for a user name and password.

Figure C.7 - Enter Password

4. Initially, the user name is user and the 
password is the corresponding password 
that was chosen in Section C.1. Enter the 
username and password and click OK.

5. The detector controller menu appears in the 
browser window. 

Figure C.8 - Browsing the x86-based CPU board or PC

6. Select the Update System link from the 
menu. The System Update page will appear 
on the right side of the window.

Figure C.9 - System update package dialog
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7. Choose the Browse button and select the 
update package with the extension *.tgz .

NOTE: Update vs. Complete (Re)Installation: 
The “Update” variant (recommended) leaves 
intact all configuration files stored on the Flash 
drive, whereas “Complete (Re)Installation” for-
mats the Flash drive before installing, discarding 
all configuration files.

8. Press the Proceed button to begin the 
update process. It should take about one 
minute.

9. When finished, a report about the installa-
tion process will be displayed.

10. The update of the PSDWARE is now com-
plete.

11. To activate the update, reboot the detector 
controller by switching it off, waiting 5 sec-
onds, and switching it on again. After reboo-
ting, the detector controller should be 
reachable with your Web browser at the 
same IP address. 

C.3  Updating the FPGA Firmware

1. To update the FPGA firmware, access the 
detector controller with a Web browser as in 
the first part of Section C.2. At the detector 
controller menu, select the Update FPGA 
of TDC link. The Update page will appear 
on the right side of the window.

Figure C.10 - Updating FPGA firmware
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2. Choose the Browse button and select the 
update package with the extension *.jbc . 

3. Press the Proceed button to begin the 
update process. It should take several min-
utes.

4. When finished, a report about the installa-
tion process will be displayed.

5. The update of the FPGA is now complete.

6. To activate the update, reboot the detector 
controller by switching it off, waiting 5 sec-
onds, and switching it on again. After reboo-
ting, the detector controller should be 
reachable with your Web browser at the 
same IP address. 

7. There are various services running on the 
system (e.g., http, telnet, ftp service, and 
the instrument control software itself). The 
use and settings of all services can be 
adjusted with the DIFFRACplus software 
package’s Config program. Consult the 
Config manual for details.

NOTE: Please do not mix FPGA and PSD-
WARE versions from different sources. The 
firmware of the VÅNTEC-1 detector controller 
MUST fit with the corresponding DIFFRACplus  
software. The firmware will be delivered either 
with the Measurement Package or with update 
CDs.
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Appendix D. EC Declaration of 
Conformity

See the figure on the next page.
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